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The purpose of this document is to provide step by step references to assist in activities needed to register 
students, set up and manage sessions and complete the IAR assessment in PearsonAccessnext. 

 
IAR / PearsonAccessnext 

1. Organization Participation 
2. User Accounts 
3. Student Registration 
4. Student Accommodations 
5. Creating Sessions 
6. Managing Sessions 
7. Student Testing Ticket 
8. TestNav 

 
Organization Participation 
Before students can be registered in PearsonAccessnext, the Invest in Kids Act school must be marked as 
participating in the Spring 2022 administration. Schools must sign up annually with Illinois State Board of 
Education. More information on the Invest in Kids Act can be found on ISBE on the Invest in Kids Act- 
Assessment page at https://www.isbe.net/Pages/testinvestinkidsact.aspx. 

 

Once registered with ISBE, Pearson will mark the schools as participating in PearsonAccessnext.   
 

PearsonAccessnext User Accounts 
IAR assessment management is within the PearsonAccessnext (PAN) website. 
https://il.pearsonaccessnext.com 

 

A training site is also available for users to practice PearsonAccessnext activities. 
https://trng-il.pearsonaccessnext.com/ 

 

When logging into PearsonAccessnext, be sure the administration is set to 2021-2022 in the upper right corner 
of the screen. If the administration does not show IAR Spring 2022, the dropdown can be used to change 
administrations. 

 
 
 

School personnel who will be setting up and administering the IAR assessment will need a user account to 
log into PearsonAccessnext. Pearson will set up an initial School Test Coordinator based on the contact 
information provided when registering with ISBE to participate in the Invest in Kids Act. If that user is a new 
user in PearsonAccessnext, they will receive an email (like the one shown below) from Pearson directing them 
to set up a password on the site. Note: users may need to check their Spam folder on their email account. 

https://www.isbe.net/Pages/testinvestinkidsact.aspx
https://il.pearsonaccessnext.com/
https://trng-il.pearsonaccessnext.com/
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Once the initial School Test Coordinator has been established, that user can create additional users in their 
school. Users within the school can be assigned various roles with most common being School Test 
Coordinator or Test Administrator. 

Users can be created manually within PearsonAccessnext or via a file import if several users need to be added. 

To create a user manually, go to the Setup dropdown and select “Users”. 
 

 
Once on the User page, use the “Select Tasks” dropdown and check “Create/Edit Users”, then select the blue 
“Start” button. 

 
 
 
 
 
 
 
 

On the “Create User” task, complete the following information: 
• Selected Organization - the organization options will appear in the dropdown when clicking in the select 

box. 
• Selected Roles - the role options will appear in the drop down. Most users will have School Test 

Coordinator and Test Administration. 
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• Active Begin and End dates are not required. 
• Complete First Name, Last Name and Email. 
• The Username will default to the email. This can be changed if desired. 

 
Once user information is complete, select the blue “Create” button. 

 

The new user will receive an email like the earlier example. 
 

Note: Users will need to be created in both the live site and the training site if the user intends to use the 
training site. Once created, one password will be used for both sites. 

 
More information on user roles and detailed instructions for user imports can be found at 
https://il.mypearsonsupport.com/resources/training-resources/IL_User_Role_Matrix.pdf 

 

Student Registration and Accommodations 
In order to take the IAR assessment, students must be created and registered within PearsonAccessnext. 
Student registration includes the student’s demographic information, grade level, tests to be taken, and any 
testing accommodations that student may need (i.e. Large Print paper document or online Text-to-Speech).  
 
To Register students for the IAR Spring 2022 assessments, school must first check to see if the student 
already exists within PearsonAccessnext.  To search for students, make sure you are in the IAR Spring 2022 
scope then go to Setup>Students 
 
 
 
 
 
 
 
 
 
On the student screen, under find students, change the drop-down from “Registered to IAR Spring 2022” to 
“by Ignoring IAR Spring 2022 Registrations”.  Under the blue Search drop-down, check the “Show all results” 
box. 
 
 
 
 
 
 
 
 

https://il.mypearsonsupport.com/resources/training-resources/IL_User_Role_Matrix.pdf
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Students in the system, but not registered for Spring 2022 will now show on the screen. Select any students 
that will be testing in 2022. 
 
 
 
 
 
 
 
 
 
Use the Select Task drop-down and choose the “Registration” tasks then select the blue Start button. 
 
  
 
 
 
 
 
 
 
 
First go to the “Manage Enrollments” tab; click in the Organizations box and select your school from the 
drop-down.  Next click the box in the top row to select all students, then select “Save”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Next go to the “Register Students” tab. Highlight each student to register individually. Check the box next to 
“Registered”. The minimal information that must be completed is the “Grade Level When Assessed” and 
the “Home School Code”.  For Invest in Kids schools, the Home School is the same as the Testing School and 
should be available in the drop-down when clicking in the Home School box.  
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Additional information can and should be completed but the student can be registered with this limited 
information. If you do not complete the additional information, you see warnings but those will not hinder 
student testing unless an accommodation is involved (see note below). 
 
NOTE on Registration tab, if the student will be testing with an accommodation that requires an IEP or 504, 
the Student With Disabilities and Primary Disability Type boxes must be complete before the 
accommodation can be added. If the student will be testing with an accommodation that requires an EL 
(English Learner) designation, then English Learner status must = Yes before the accommodation can be 
added.  
 
After the student(s) are registered, students must be assigned a test. This is done on the Manage Student 
Tests tab.   Each student will need to be registered for both an ELA and a Math test.  
 
Select the student under the Student drop-down and add the Test.  The minimal fields that must be 
populated to create a test are the Student, Test, Organization and Test Format.  Once complete, select 
Create. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional fields must also be completed if the student will be testing with an accommodation, especially if 
it is an accommodation that requires a specific form or TestNav accessibility feature.  

 
Students who are not currently in the system can be created and registered either 
manually within the system or via a file import.  
 
For Spring 2022, the create new student feature will be available after February 1, 2022.  Prior to that date, please 
call the Pearson Support at 1-833-213-3879 for assistance in adding new students.  

 
To create and register a student manually, go to the “Setup” dropdown and select “Students”. 
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On the Student page, use the “Select Tasks” dropdown, select the shown options and click the “Start” button. 

 
On the Create / Edit Students tab, complete the core student information and select the “Create” button.  

 

 
On the Register Student tab, check the “Registered” box, complete the required fields and any additional 
demographic data and choose “Save”. 
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All students must have both an English language arts (ELA) and a Mathematics test assigned to them. Test 
can be created manually using the Manage Student Test tab. Each test must be created separately. At a 
minimum the following fields must be completed: 

• Student - select from the drop down (all students either newly created on the previous tab or 
selected on the student page will appear. 

• Test - select the appropriate grade ELA or Math assessment. (one test must be created for each 
subject) 

• Organization - select from the dropdown. If at a school level, only that organization will be available. 
• Test Format - online or paper must be selected. If paper is chosen after the deadline for initial paper 

orders, then an additional order must be placed to receive materials. The deadline for initial orders 
for Spring 2022 is January 28, 2022. 

o For assistance with placing an Additional Order, if necessary, contact the support center at 
1-833-213-3879 or visit customer support at https://il.mypearsonsupport.com/support/ 

 

IF there are no testing accommodations needed for the selected student / test, then click the blue “Create” 
button on the right or bottom of the screen. 

 

 
 

Student Accommodations 
IF the student has any specific accommodations or accessibility features for testing, these can also be added 
on the “Manage Student Tests” tab. 

 

https://il.mypearsonsupport.com/support/
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For step by step details regarding adding student accommodations manually within PearsonAccessnext, refer 
to the Guide to Manually Enter Accommodations and Accessibility Features into PearsonAccessnext 
https://il.mypearsonsupport.com/resources/training- 
resources/Guide%20for%20Adding%20Accommodations%20Manually%20within%20PearsonAccessNext.pdf 

 
For detailed information on all accommodations and accessibility features including what the testing impact, 
refer to the Accessibility Features and Accommodations Manual 
https://il.mypearsonsupport.com/resources/training- 
resources/AccessibilityFeaturesandAccommodationsManual(BodyandAppendices)-Full%20Document.pdf 

 
Create and register a student via the Student Registration/Personal Needs Profile 
(SR/PNP) file 
To create and register NEW students, download the csv file layout and the IAR Spring 2022 SR_PNP 
Detailed Layout located on the IAR Pearson Support page on the Resources tab.  Before importing new 
students check to see if the student already exists in PAN per directions on page 3. 

 
https://il.mypearsonsupport.com/training-resources/ 

 

The csv file will provide the appropriate headings and template for the file import. The Detailed layout 
provides the valid values and examples for completing the file. 

 
Below are additional notes for completing the SR/PNP file layout; some notes are specific to Invest in Kids 
schools. 

 
Column Heading Notes 

A State Abbreviation This must be populated with “IL” 
B Testing District Code This is the 15-byte Organization code found in the 

upper right corner of the PearsonAccessnext screen 
once logged in. The district code is the first set of 
numbers shown and will be one of the following: 

 
9999999999X0000 
9999999997X0000 
9999999998X0000 

C Testing School Code This is the 15-byte RCDTS code from ISBE. It is the 
second set of numbers in the upper right corner of 
the PearsonAccessnext screen. 

D Home District Code These can be left blank for Invest in Kids schools. It 
will default to the same as the Testing District. 

E Home School Code These can be left blank for Invest in Kids schools. It 
will default to the same as the Testing School. 

F State Student ID from SIS On the initial import to register students this 
should be left blank. The system will assign an ID. 

 

https://il.mypearsonsupport.com/resources/training-resources/Guide%20for%20Adding%20Accommodations%20Manually%20within%20PearsonAccessNext.pdf
https://il.mypearsonsupport.com/resources/training-resources/Guide%20for%20Adding%20Accommodations%20Manually%20within%20PearsonAccessNext.pdf
https://il.mypearsonsupport.com/resources/training-resources/AccessibilityFeaturesandAccommodationsManual(BodyandAppendices)-Full%20Document.pdf
https://il.mypearsonsupport.com/resources/training-resources/AccessibilityFeaturesandAccommodationsManual(BodyandAppendices)-Full%20Document.pdf
https://il.mypearsonsupport.com/training-resources/
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  On any subsequent imports (if needed), the user 
should first complete a student export, update that 
file and import so the student IDs are included. 

 
NOTE: starting in Spring 2021, the system will 
assign one ID per student based on the student 
demographics. Duplicate students will not be 
created. 

G Local Student ID This is an optional field. It can include a value or be 
left blank. 

H Unique Pearson ID This field should be left blank on initial imports. On 
any subsequent imports, users should first do a 
student registration export, update that file, then 
import. This field will contain a Pearson value at 
that time. 

I-M  Student information fields for name, dob, gender 
N State Field 1 All State Fields can be left blank 
O Grade Level When 

Assessed 
This is the grade of the student. 03-08 (3-8 
accepted). 

P-W  Race/Ethnicity fields. Valid values are Y=Yes, N=No 
and Blank. (Column V is a filler field and should be 
blank) 

 
Note: at least one of these fields should be 
completed. 

X English Learner (EL) Valid values are Y=Yes, N=No and Blank. 
Note: some accommodations must have EL = Y if 
chosen. 

Y Title III Valid values are Y=Yes, N=No, X= Not Collected or 
N/A and Blank. 

Z Gifted and Talented Valid values are Y=Yes, N=No, X= Not Collected or 
N/A and Blank. 

AA Migrant Status Valid values are Y=Yes, N=No and Blank. 

AB Economic Disadvantage 
Status 

Valid values are Y=Yes, N=No and Blank. 

AC Students with Disabilities Valid values are IEP, 504 or B = Both IEP and 504, 
N=No and blank. 

 
Note: you must have IEP, 504 or B as this value in 
order to chose certain accommodations. 

AD Primary Disability If field AC has IEP or B, then this field must be 
populated. NC = not collected is acceptable. 

Note: For fields X - AC, If left blank you may see a “warning” in PearsonAccessnext (PAN), however 
this will not cause any issues with testing or reporting. 
AE - AR State Field use These should all be left blank 

AS Session Name This field is used to auto create sessions using the 
SR/PNP file import. See section “Session Creation 
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  and Management” for more information. 
AT Class Name Optional field 
AU Test Administrator Optional field 
AV Staff Member Identifier Optional field 
AW Test Code This field must be populated with the student test. 

On record should be created for each student. One 
record for the ELA test and one record for the 
Math test. Both records can be imported on the 
same file. 
Valid Values: 
ELA03 MAT03 
ELA04 MAT04 
ELA05 MAT05 
ELA06 MAT06 
ELA07 MAT07 
ELA08 MAT08 

AX Test Format This field must be populated. 
Valid values are O = Online / P=Paper 

 
If paper is selected after the 2/5/21 deadline for 
initial orders, an additional order must be placed in 
order to receive paper materials. 

If there are no testing accommodations or accessibility features needed, the remaining fields (AY- 
CL) can be left blank. All headings in the csv header row must however remain in the file. 

 
IF the student has a testing accommodation or accessibility feature, see the Detailed Layout for 
valid values of each field. 

 
NOTE: Even if you use the SR/PNP import for your initial student registration, accommodations can 
be entered later either manually or via another import. If importing another SR/PNP file later, be 
sure to first do at Student Registration Export to ensure all student information is reloaded 
correctly. 

CM End of Record Must have value = Y 
 

The file must be saved as a .csv file, not excel. Because of this, some formatting issues may occur with 
Columns C and E (Testing and Home School Codes). If the school RCDTS code begins with a zero, you will 
need to custom format those columns for 15-bytes. 

 
To format, right click on the column (C) and choose “Format Cells”. Then on the Number tab, select 
“Custom” and type 15 zeros in the Type box and say click “OK” 

                                                 



 

Save the file as a .csv by choosing File>Save as then selecting .csv in the file dropdown (in this example CSV 
(MS-DOS) (*.csv) is chosen. If using a Mac computer, select that .csv option. 

 

To import the SR/PNP file, go to Setup>Import/Export Data. In the “Type” dropdown, select “Student 
Registration Import”. 

 

 
 
 

Click “Choose File” and select the .csv file you created earlier. 
 

Do NOT check the box that says “Don’t modify student tests”. This option should only be selected when 
updating demographic data without updating test registration data. 

 
The check box “Don’t auto-create Test Sessions for online testing” is the option that can be used to create 
test sessions and add students to those sessions. (See Create and Manage Session section for more details). 

 
If you are doing an initial student registration and do not want to create sessions with this file import, then 
check the box. If you are creating sessions or importing a file specifically to create sessions, then make sure 
the box is checked. Be sure to complete the session information in field AS - Session Name of the file layout. 

 
Once a student is added to a session in PearsonAccessnext, they must be removed from that session before 
they can be added to a new session. 

  



 

To manually create a session, under the “Testing” dropdown, select “Sessions”. 
 
Once on the Sessions page, use the “Select Tasks” dropdown and choose 
“Create/Edit Sessions” and click “Start”. 

Additional details on how to import/export the file, as well as how to check for errors on the import of the 
Student Registration/Personal Needs Profile file can be found in the Field Definitions document at 
https://il.mypearsonsupport.com/resources/training-resources/IAR-Spring-2021-SR-PNP-Field- 
Definitions%20V1.0.pdf. 

 
This document contains references to ISBE’s Student Information System (SIS) that do not apply to schools 
participating in the Invest in Kids Act and can be ignored. 

 
Session Creation 
All students testing online must be placed in a session in PearsonAccessnext. Students testing on a paper 
form, do not have to be in a session. 

 
Sessions can be created, and students added either manually within PearsonAccessnext or via the Student 
Registration/Personal Needs Profile (SR/PNP) file import. 

 

 
 

On the “Create/Edit Sessions” tab, complete the following information: 
• Session Name - this can be whatever makes sense for the school. Many sessions are created using 

the teacher/grade/subject (example: jonesG3ELA). 
• Organization - choose the school from the dropdown. 
• Test Assigned - Each grade and subject must be in a separate session in PAN. 
• Scheduled Start Date - The schedule start date must be added but note that this does not affect 

when sessions can actually be started. It can be the date the session was created or the date of 
testing start. 

• Form Group Type - For most sessions this will be “Main” from the dropdown. IF students are using 
the accommodation for Human Read Aloud, then the box “Proctor Reads Aloud” must be checked 
and the Form Group Type must be “Human Reader”. 

• Precaching Computer - It is not necessary to set up a Precaching Computer but you may need to use 
the dropdown and choose “no caching” if prompted. 

 
Students can be added during the creation of the session by click in the “Students” box at the bottom of the 
Session page. Students who have a test set up for the grade and subject matching the session grade/subject 
will appear in the dropdown and can be selected for that session. Students who are already in another 
session for that grade/subject will not appear. Once all desired students are added, click the “Create” 
button. 
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https://il.mypearsonsupport.com/resources/training-resources/IAR-Spring-2021-SR-PNP-Field-Definitions%20V1.0.pdf
https://il.mypearsonsupport.com/resources/training-resources/IAR-Spring-2021-SR-PNP-Field-Definitions%20V1.0.pdf
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Students can also be added later by going to the Session page. To show all sessions that have been created, 
you may need to use the “Search” dropdown and click the box for “Show all results”. 

 

 
 

From the “Select Tasks” dropdown, check “Add/Remove Students in Sessions” and click the “Start” button. 
 

 
Eligible students for that grade/subject session will show when clicking the select a Student box. After 
selecting students, you much check the box next to the student then click “Save”. 

 

 
The SR/PNP file can also be used to import sessions. This import will create sessions and add students to 
sessions at one time. The session information can be included in the initial file import when registering 
students or an additional file can be imported later. 

 
To import a file for session creation after the original SR/PNP file has been loaded, first do a Student 
Registration Export. Under the “Setup” dropdown, choose “Import/Export Data”. Next, using the “Select 
Tasks” dropdown, check “Import/Export Data” and click “Start” 

 

 

 
Under the “Type” dropdown, select “Student Registration Export”. Under Test Status Filter, the default is 
“assign” and “testing”. Keep these filters. The additional filter is “attempt” which is not needed for this 
export. You can select a grade and subject if desired, but if these are left blank, the file will include all 
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students and all grades. Click the “Process” button. 
 

 
You can monitor the download progress and click the “Download File” button when the file has completed 
processing. 

 

 
Open the exported/downloaded file and complete field AS-Session Name field for all online students. You 
can split the students into as many sessions as desired but there must at least be a separate session for each 
grade and subject. Once complete, save as a .csv file and import using the Import/Export task described 
under the student registration section. 

 
Human Reader Accommodations 
Students who have the human reader accommodation for online must all be placed in a session specific to 
Human Reader. This ensures that all the students in that session will receive the same form. Users can 
import students via the SR/PNP file to include Human Reader Sessions, but the session will need to be 
edited within PearsonAccessnext to have the Proctor Read Aloud box checked and Form group changed to 
Human Reader from Main. See more information under manual session creation above. 

 
If a student has an incorrect accommodation or needs an accommodation added later, that can be done on 
the session management screen or via another SR/PNP import. However once the session is prepared there 
are additional steps that need to be taken to be sure the student tests with the correct accommodations. 
Please see the document Personal Needs Profile Guidance on the support page for additional information. 
https://il.mypearsonsupport.com/resources/training-resources/PersonalNeedsProfile(PNP)Guidance- 
ManagingIncorrectAccessibilityFeaturesandAccommodationsPNPV2.pdf 

https://il.mypearsonsupport.com/resources/training-resources/PersonalNeedsProfile(PNP)Guidance-ManagingIncorrectAccessibilityFeaturesandAccommodationsPNPV2.pdf
https://il.mypearsonsupport.com/resources/training-resources/PersonalNeedsProfile(PNP)Guidance-ManagingIncorrectAccessibilityFeaturesandAccommodationsPNPV2.pdf
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Session Management 
Once sessions are created and students have been added to sessions, nothing more is needed until the 
testing window. In order to test, sessions must be prepared and started, and units must be unlocked. 
Detailed information about session management can be found in the Starting Test Sessions, 
Locking/Unlocking Units, and Resuming Test Guidance located at 
https://il.mypearsonsupport.com/resources/training- 
resources/Starting_Test_Sessions_Locking_Unlocking_Resuming.pdf 

 
Student Testing Ticket 
A student must have a Student Test Ticket in order to log into TestNav. Student Testing Tickets are printed 
from within the Students in Sessions screen in PearsonAccessnext. Select your session(s) either by selecting 
“Testing>Sessions” and checking the box next to the session name(s) then going to “Students in Sessions” or 
by using the “Add a Session” option on the “Students in Sessions” screen. 

 

 
Once the session or sessions are selected, use the “Resources” dropdown from the “Students in Session” 
screen to print the Student Testing Tickets. Tickets for all students in the session or individual selected 
students can be printed. 

 
 
 
 
 
 
 
 

Tickets for all sessions can be printed by highlighting “Combined View” for all sessions selected on the 
“Students in Session” screen. 

 
The Student Testing Ticket provides the Username and Password information needed to log into TestNav. 

 

https://il.mypearsonsupport.com/resources/training-resources/Starting_Test_Sessions_Locking_Unlocking_Resuming.pdf
https://il.mypearsonsupport.com/resources/training-resources/Starting_Test_Sessions_Locking_Unlocking_Resuming.pdf
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TestNav 
All students must have the TestNav application downloaded on their devices in order to take the IAR 
assessments. 

 
TestNav downloads can be found at https://download.testnav.com/ 

 

Technology requirements and resources are available on the Il.mypersonsupport.com resource site. 
https://il.mypearsonsupport.com/technology-setup/ 

 

This includes TestNav Online Support 
https://support.assessment.pearson.com/display/TN/TestNav+8+Online+Support 

 

Student devices who were set up for Spring 2020 will need to be updated to the current version of TestNav 
prior to testing. 

https://download.testnav.com/
https://il.mypearsonsupport.com/technology-setup/
https://support.assessment.pearson.com/display/TN/TestNav%2B8%2BOnline%2BSupport
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